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PHARMACOLOGY

Introduction

This chapter is a short tutorial on model building using the Berkeley Madonna FlowChart interface.
We do this within the context of pharmacology because of the abundance of pharmacology models
that are both simple and practical. Pharmacology models are designed to predict the time
dependence of a drug's concentration in the body fluids following its administration, or to model the
action of the drug once it reaches its target organ. The complexity of pharmacological models varies
widely depending on the level of detail they encompass. We begin by representing the whole body
as a single compartment; that is, a homogeneous volume. This simple model will provide us with an
easy introduction to modeling with Madonna, and suffices to introduce the general concepts of
steady state, exponential response, relaxation time, and the principle of superposition in linear
systems.

Although the single compartment model yields useful results in many cases, it is not a very realistic
representation of the body, especially if we are interested in the distribution of a drug into different
tissues. So the next step up in complexity is to model a body as two interconnected compartments: a
central compartment that includes the blood and tissues like the liver and kidney, that have a rapid
and profuse blood circulation, and a second peripheral compartment that includes the more slowly
perfused tissues. While more successful than a one compartment model, the abstract nature of the
two compartment system makes it difficult to assign anatomical locations to the compartments, and
to give physical interpretations to its parameters. These issues prompt us to move on to more precise
and more elaborate physiologically based pharmacokinetic models which take explicit account of the
blood supply to each represented tissue. Finally we conclude this chapter with an introduction to the
more complex and more challenging problem of the action of drugs at their target site.

One Compartment Pharmacokinetics

We begin with the simplest case where we infuse into the body the biologically inert polysaccharide,
inulin. Inulin is infused into animals or humans to trace fluids; it is used to estimate the volume of
extracellular fluids as well as the rate of filtration of blood plasma fluids into the kidney nephrons.
This filtration rate, a fundamental parameter for investigation and evaluation of kidney function, is
calculated from measurements of urinary flow and urinary and plasma concentrations. Interpretation
of these measurements requires some notion of how the inulin concentration in the plasma changes
following its administration by injection or infusion. Following the start of an inulin infusion, the
plasma concentration rises rapidly. When will the concentration stabilize?

Model Summary

The model computes the inulin concentration in the plasma at any time. It does this by comparing
the amounts entering the body with the amount leaving at each moment; any discrepancy must
represent a gain or loss of inulin within the body. Adding all these gains (or losses) up to a particular
time computes the amount and concentration of body inulin at that time.
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Figure 1. Changes in the inulin body compartment depend on the entry and exit flow rates.

The results enable us to study and evaluate protocols for making measurements of extracellular
volume and of renal filtration.

Model For The Accumulation Of Inulin In The Body Fluids

Building the Model --- Step by Step Before starting, verify that the flowchart editor
is functioning properly. To do this, choose
In this section, we construct our inulin model | About Berkeley Madonna from the Help

graphically using the flowchart editor. The menu and look for text that reads “Flowchart
model consists of three dynamic elements: a version 8.0.1”. If it says “Java not loaded”,
reservoir icon (compartment) representing click the Load Java button. If Java fails to
the mass [mg] of inulin in the body fluids, load, you need to install (or reinstall) Java™
and two flow icons representing inulin support on your system.

entering and leaving the body [mg hr'']. In
addition we will employ supporting formula icons to represent the rate of rate of renal filtration [L
hr''], volume of body fluids L, and the concentration of inulin [mg L™']. Begin:

1. Choose New Flowchart from the File menu. An empty flowchart window appears.

2. Position the mouse over the reservoir tool ﬂ, press the mouse button, drag the reservoir to

the flowchart, and release the mouse button. You’ve now placed a reservoir on the flowchart
with the default name R/. Note that the reservoir is colored red which means it is selected.

3. Change the name of the reservoir to m by typing the new name. (It is not necessary to first click
the reservoir since it is already selected.) This single reservoir represents the total mass in
milligrams [mg] of inulin which we assume is uniformly dissolved in the extracellular fluid.

4. Click the flow tool , move the mouse over the mass reservoir, press the mouse button, drag

the mouse to the right a few inches, and release the mouse button. This places a flow icon on the
flowchart which drains the mass reservoir into an infinite sink.

5. Make sure the reservoir is connected to the flow. If the flow looks like this:
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6. Change the name of the flow to Ex (for exit) by
clicking the spherical part of the flow icon (if it is not
already selected) and typing the new name.

10.
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its source end is not connected to the reservoir. In this case, drag the infinite source on the
left to the reservoir and drop it. This connects the flows input to the reservoir instead of an

infinite source.

Click the flow tool again and move the mouse an inch
to the left of the mass reservoir, press the mouse button,
drag the mouse to the right until the cursor is over the
reservoir, and release the mouse button. This places a
flow to inject inulin into the body fluids reservoir.

Rename this icon /nj. As before, make
sure you have connected the right hand
side to the reservoir. If not drag the
infinite sink on the right onto the
reservoir and drop it by releasing the
mouse button.

If you find that the icons are not
positioned the way you want, they can
be repositioned by clicking and
dragging. Note that Berkeley Madonna
maintains the connection between the
reservoir, flow, and sink.

Place 3 formula icons non the

flowchart near the Ex flow icon (use the
same click and drag technique as you
did for the reservoir). Change the
names of the formula icons to V, C, and
k.. V will represent the volume of
extracellular . The units will be liters
[L]. C is the concentration of inulin in
the extracellular fluid in units of
milligrams per liter [mg L™']. k. is a
proportionality constant [mL hr']

You can remove an icon or arc
from the flowchart by selecting it
and choosing Clear (Macintosh) or
Delete (Windows) from the Edit
menu. You can also remove
selected objects by holding down
the Control key while pressing the
delete or backspace key.

You can change the position of the icon labels
by simply dragging them around. (Madonna will
prevent you from straying too far from the icon.)
You can also change the curvature of the
dependency arcs by dragging their control
points. To do this, first select an arc by clicking
somewhere along its trajectory. The arc will turn
red and a small square handle (control point)
will appear. Click and drag the control point to
change the arc’s trajectory.

Icons and arcs can be removed by selecting them
and choosing Clear (Macintosh) or Delete
(Windows) from the Edit menu. You can also
remove selected objects by holding down the
Control key while pressing the delete or
backspace key. Try deleting the arc from the V
icon to the C icon. Note that a question mark
reappears in the C icon because the icon’s
equation still shows that C depends on V, but
this dependency is no longer shown on the flow
chart. You can reestablish this dependency by
drawing a new arc from the V' to the C

relating the rate of inulin excretion to its concentration

Click the arc tool and create an arc going from the reservoir icon to the C icon (use the

same technique as you did for the flow). This creates a dependency relationship between the
concentration and the mass of inulin. Create another arc going from the V icon to the C icon.
Now our diagram shows that C depends on both m and V. Finally, use an arc to connect C to Ex
and use another arc to connect k. to Ex. These last two connections show that the rate of
excretion of inulin by the kidney depends on how fast fluid flows into the renal nephron as well
as the inulin concentration in the body fluids. Your flow chart should resemble Figure 2.
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Figure 2. Inulin Model before
setting the model

Inj _|
parameter values. &2 > r7\—> [=]

11. So far we have not supplied the model with any numerical values. Madonna indicates this by the
question marks on the icons. Double-clicking on any icon will open a dialog box asking for
numerical data. For example, double-click on the C icon. The dialog box says that m and V" are
required inputs. This means that these variables must be used in the right-hand side of the
equation defining the icon’s value. Enter m/J in the data box. You can type in the names from
the keyboard or, more conveniently, simply double-click on the input’s name in the list. Click
OK (or press Return) when done, and the dialog box will close; the question mark on the icon
has disappeared indicating that Madonna is satisfied with your input to the flow icon. Next we
must assign numerical values to V" and k. The basis for these values is discussed in the
Parameter Estimation box.

Parameter Estimation

The molecular weight of inulin is ~ 5000, so it is too large to pass through cell membrane channels,
but it is small enough to easily pass through porous capillaries. There are no other significant
transport pathways for inulin. Therefore, to a good approximation, we can assume inulin is
uniformly dissolved in the extracellular fluid that makes up about 20% of the body weight. The
extracellular volume for a 70 kg body is 14 liters [L] (20% body weight = 0.20 x 70 kg = 14 kg ~ 14
L).

We calculate the rate constant k for excretion from the mass action relation Ex = £.C. Since inulin is
biologically inert, its only escape from the body fluids is by renal excretion so Ex is easy to measure:
simply collect the urine that flows over a glven period of time, measure its inulin content and divide
by the collection time. When C = 100 mg L™, typical Values of Ex are around 720 mg hr™'. Using
these figures, we estimate k. = Ex/C = 720/ 100 72Lhr'.
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Double-click the k. icon and enter 7.2. Note that you can use the dialog’s calculator keypad to
insert digits and common arithmetic operators. Double click the V icon and enter 14.

Double click the reservoir (m icon). In this dialog, you specify the reservoir’s initial value. Since
there is normally no inulin in the extracellular fluids, we assume there is none at the beginning of
the experiment, so enter 0 and close the box.

Now double click on the flow icon (click in the center circle with the question mark). k. and C
are required, so enter their product, k. C, and click OK. (Flows are rates and have time in their

dimensions. The dimensions of k. = [L-hr”" ] while C = [mg-L"'] so that the dimensions of the
product k. C = mg-hr, the rate that the reservoir is losing inulin.

Double click on the last unfilled icon, /nj. We will simulate a constant infusion at the rate 600
mg-hr'. Enter 600 in the dialog and click OK

The model flowchart is now complete, and all question marks should have disappeared. Now run
your model by choosing Run from the Compute menu. Berkeley Madonna runs your model and
displays the results in a graph window. Click on the button labeled L located on top of the graph
to insert a Legend on the graph. Click the button again to remove the legend. All buttons on the
graph are toggle (on-off) buttons.

Figure 3. The graph window.
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The graph shows the variables m, whose scale is on the left vertical axis, and Ex scaled on the
right. (Madonna automatically plots the first two variables that were defined in the construction
of the model window The first is scaled on the left axis, the second on the right.) There are 3
toggle buttons located on the left bottom margin of the graph window. Click on the C button.
This will place a plot of C on the graph. Click on the Ex button to remove Ex. Both m and C are
scaled on the same left hand axis. To scale one of them, say C, on the right, click on the C button
while holding down the shift key.
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Madonna automatically places buttons for the first eight variables on graph window (we have
only three). You can over-ride this default and completely control which buttons appear on the
graph by double clicking anywhere in the Graph window to bring up the Choose Variables
dialog (see Menu item Help>How Do I>Control Plotted Variables).

To see a tabular representation of the numerical results, click on the Table button . The

graphical representation of our results is replaced by an equivalent numerical table. Relevant
buttons on the table have the same function as on the graph. Also, double clicking in the middle
of the table brings up the Choose Variable dialog. Click on the Table button once more to return
to the graph.

To change parameters, select Parameter Window under the Parameters menu.

e O Untitled 1 - Parameters

“ Run ) | Runge-Kutta 4 T]

Select /nj in the list and then change the 600 that appears in the Edit box (above in the gray area)
to 300. Click Run: the previous results are erased and the new simulation with /nj = 600 is
plotted. The asterisk on the 300 in the parameter list indicates that the parameter has been
changed from its original value. If you would like to restore the original, select the parameter and
click the Reset button. If you would like to compare two simulations on the same plot, click on
the Overlay button labeled O, and run once with /nf'=300 and once with /nf'=600. Activating the
Overlay button stops Madonna from erasing the plot each time a new run is initiated. Like all
graph buttons, Overlay is toggled on or off by clicking on it.

20. Now that you’ve created a useable model, you should take a look at the equations Berkeley

Madonna generated. To do this, choose Equations from the Model menu. Position the equations
along side the flowchart so that you can see both windows simultaneously.
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® © © Inulin Model - Equations

“Run’

{Top model} O

{Reservoirs}

. . . . d/dt(m) = - EX + Inj
Figure 5. Equation Window obtained from the menu INITm =0 S
Model>Equations.
{Flows}
Ex = k*C
Inj = 600

{Functions}
C=myV
k=72
V=14

When you select an icon in the flowchart, Berkeley Madonna highlights the corresponding
equation(s) in the Equation window. This makes it easy to see an icon’s equations without
opening its icon dialog. Conversely, you can show which icon corresponds to an equation in
the equation window. Simply position the equation window’s insertion point (caret) within
one of the equations, then choose Show Icon from the Edit menu. This activates the
flowchart window and highlights the corresponding icon.

You can also open the icon dialog directly from the equation window by double-clicking an
equation. For example, double-clicking anywhere within the line C =m/V opens the icon
dialog for the C icon. Select the m reservoir, type Inulin and press return. The name of the
icon changes and Berkeley Madonna updates the name in all equations that depend on it. To
see this in action, change the name again and keep your eye on the equation window as you
press the return key. Change the name back to m

The model predicts an exponential response

Many experiments begin with a system in a steady state where all flows are constant and the
reservoir levels are unchanging. The system is suddenly perturbed, for example by a sudden
concentration change, after which the system moves to a new steady state. We can use the model to
determine the new steady state and how long it took to get there.

The steady state

Whenever the flow into the body through injection is equal to the flow out through excretion the
system is in a steady state condition; that is, the flow, /nj, into the reservoir m is equal the flow out
Ex = k.C. Then the steady state concentration of inulin will be given by

Equation 1 steady state:  C =Inj/k, [mg/L]
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When Inj = 0, C = 0; this is our initial condition (a trivial result simply restating what we already
knew: inulin is not a normal body constituent). When /nj = 600 mg/hr, the final steady state
concentration is C = 600/7.2 = 83.3 mg L. You can verify this on the graph by ‘zooming in’ to view
the last portion of your plot: click and drag the mouse to draw a rectangle over the relevant area.
When you release the mouse, Berkeley Madonna adjusts the axis limits so that the portion that was
in the rectangle now fills the window. To undo the effect of a zoom-in, click the Z button located in

the toolbar on top of the plot. Now click the Readout button, on the Graph window toolbar

and place, the ‘crosshair” cursor -$— over a point on the plot; the coordinates are displayed

in the information area at the top of the window. Alternatively, you could view the data in
Table form and scroll down to the last time row.

More complex models will have more reservoirs, but the same considerations hold: in a steady state
the inflow to each reservoir must equal its outflow. This can involve finding roots of a complicated
set of simultaneous algebraic equations, but Madonna has provisions for finding the required
numerical solutions.

Relaxation Time

Letting 7= V/k., the mathematical solution for the inulin model as derived in the MATH NOTES box:
The exponential response is:

Equation 2 C(t)= %(1 - e_TJ

c

C(t) approaches asymptotically (but never really reaches) the time independent steady state. So it
makes no sense to ask how long it takes the system to reach its final destination. Instead, we ask how

long it takes for C to reach a prescribed fraction of its final value, say 50%. In general, ¢ " will
reach the 50% mark when t = 0.69-t (¢*® = 1/2). The half-time, t,, is given by

Equation 3 t;, =0.69-1

Rather than carry around the numerical factor 0.69, we use 7 itself as a measure of the time scale of

an exponential process. 7T is called the relaxation time or sometimes the time constant; it is the time
required for the exponential to reach 63% of its final value.

In addition to the notational convenience, relaxation times are preferred because they have a physical
interpretation: they measure the mean residence time of a molecule in the reservoir. In our inulin
example each injected inulin molecule has a different fate. After an injection into the circulation
some molecules travel to the kidneys and are excreted almost immediately. Others escape into tissue
spaces and may meander around for long periods before entering the kidney. These molecules may
have ‘life times’ of many hours. The mean residence time is the average lifetime of all the injected
molecules, and this turns out to be equal to the relaxation time . This is derived in the MATH NOTES
box: The mean residence time. Similar conclusions hold for any exponential process; for example,
the relaxation time ( = ¢, /0.69) for radioactive decay equals the average time that molecules persist
before undergoing a radioactive disintegration.
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If the outflow of x from a reservoir is k-x, then the relaxation time = k'

The outflow from any reservoir depends in some way on how much is in the reservoir—no contents
means no outflow. The simplest assumption sets the outflow proportional to the contents and this
turns out to be a good approximation in many cases. The proportionality constant is a rate constant,
that governs how fast the contents are leaving the reservoir; it has the dimension time™. It is shown
in the Math Notes box that the mean residence time, or the relaxation time, is given by the reciprocal
of this rate constant. If the quantity in the reservoir is denoted by x and the out flow is equal to kx
where £ is a constant, then the relaxation (and mean residence) time is given by k™.

MATH NOTES: EXPONENTIAL RESPONSE

During the time between ¢ and ¢ + dt, Injedt mg of inulin enter the body and Exedt leave. Letting
dm represents the net gain of body inulin during that same time, we have dm =, Injedt — Exedl.
Dividing both sides by dt leaves

dm m
—=Inj—Ex=Inj—k*C=1Inj—k*—
dr 7 J J Vv

To integrate introduce a new variable x = Inj — k*m/V", and note that x = dm/dt. Then
dx/dt =- (k/V)edm/dt=- (k/V)*x and

@:_Edt
X \%

Integrating both sides between the start time (¢ = 0, m= 0 and x=xy = Inj ) and some later time with
t = tand x = Inj — k*m/V, we have

X Inj—k+*m/V k
logh— =logn————=——¢
Xo Inj V

Substituting m/V =C, k/V =1, and solving for C yields Equation XXX:

C:Iﬂ[l—e_fj
k

At some arbitrary time after the injection begins it will be stopped and the inulin that has
accumulated within the body will be excreted. At this time, reset the clock to t =0 and let Cy and
my denote the corresponding inulin concentration, and mass respectively. To find the concentration
for ¢ > 0, we use the same derivation, but now at t= 0 we have m = my , Inj =0, and x=x9 = — k*m,/V
=—k*C, . Using the arguments above, we arrive at:

m C L

—_—=—=e 7

m, C,

o
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Note that the relaxation times for the uptake and decay processes are identical

MATH NOTES: MEAN RESIDENCE TIME

Assume that at any arbitrary time we set # =0 and label the inulin molecules present in the body. Let
there be Ny of these molecules and let us note the time each labeled molecule leaves the body. If n;=

the number of labeled molecules that leave at time #;, then the average time a molecule spends in the
body is given by

L omhtmh o,
mean ~ -
NO NO

We can calculate these times from our results . We begin with Ny molecules at 1=0. Since the
number of molecules at any time N is proportional to m, we have

t

N=Nge *

and the number that leave in the time interval between #; and #+d! is given by —dN,, (The minus sign

occurs because we are counting the number of molecules that leave the body for the environment -
each time the environment gains one, the body loses one)

14
—dN, =—ﬂdt _1 e °
dt T

Using this result together with our expression for the mean, we have

tmean = L i (_le)tt = i[% e_t?i }ldt

No i=1 i=1

As dt gets smaller, the sum approaches the following integral that we evaluate using standard
integral tables:

PR
toin = T—e dt=1
0 T

Note that this result (... = 7) was derived entirely from the rate of disappearance of molecules. As
long as this rate is independent of incoming molecules (e.g. when Ex is proportional to C), the result
is also independent of incoming molecules.

10
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Dosage regimens

In the inulin model the inulin plasma concentration is proportional to the amount of drug in the body
(C =m/V) and its excretion rate is proportional to the plasma concentration (Ex = k-C) But unlike
inulin, drugs are not inert. They are absorbed on plasma proteins, dissolve in fatty tissue, and enter
cells where they may be metabolized. To model the fate of an injected drug we can use the same
approach to compute C and Ex, but the constants of proportionality are now empirical quantities
that may not have an explicit physical interpretation. We write formally as before

m
Equation 4 C=—
quation v,

Equation 5 E =k C

where V; and k. are experimentally determined parameters. V; is called the volume of distribution,
and k. is called the clearance. Loosely speaking, V;is a volume ‘corrected’ for absorption and
solubility in different tissues, and k. accounts for metabolic destruction as well as excretion (see
Empirically defined parameters box) These two parameters are very useful because their values
for virtually any common drug are listed in tables found in textbooks and handbooks of
pharmacology

Empirically defined parameters

The use of an empirical constant to correct for absorption and solubility is valid only over the range
of drug concentrations where absorption and solubility are linear functions of concentration. For
example, if the amount of drug absorbed = a-C and the amount dissolved in fatty tissue = bC,
where a and b are proportionality constants. Then the total amount in the body = m = VC +aC +bC
= (V+a+b)C. Solving for C leaves

__m _n
V+a+b V,
sothat V; =V +a + b.
Similarly, if drug removal by metabolism and excretion are both linear then
Ex=k, .C+k, C=(k, . +k, )C=kC

‘metab excr

where keqp and k... are constants. Thus, the clearance, k. = kierap + Kexer

Unlike inulin, drugs have biological effects, some desirable, some not. A common problem is to
determine a dosage regimen (schedule) to produce plasma concentrations that are high enough to

11
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produce the desired effect, but low enough to avoid toxic reactions. We illustrate this in the
following example of the pharmacokinetics of the bronchodilator theophylline, a common ingredient
in tea. It is used clinically to dilate the air passages and relieve the symptoms of chronic asthma. It is
effective at plasma concentrations of 10-20 mg-L™', but concentrations beyond this are considered
toxic. Our problem is to develop a dose schedule that will maintain a steady concentration within the
effective range and will not spill over beyond the toxic limits.

The theophylline clearance is k., = 2.88 L-hr' and its distribution volume is ¥, = 35 L (Katzung, B.
1998. Basic and Clinical Pharmacology. Stamford CT: Appleton & Lange). Use this data to change
your inulin model to a model for theophylline.

Begin by opening the inulin model and saving it with a new title. Change the labels so that V' is
replaced by V. Include formula icons for the magnitude of the dose and the interval between doses

as shown in Figure 6.

Figure 6.
Theophylline Model

Dose‘

A

Interval |

Cee e

To simulate discrete intravenous injections,
click on Inj and replace the numerical figure
with the following function that delivers a drug
pulse of size Dose starting at time = 1 and
repeating with interval Interval

PULSE(Dose, 1,Interval)

Set Dose = 100 and Interval = 24. This
specifies a series of injections of 100 mg
starting at the beginning where time = 1 hour
and repeating every 24 hours. The PULSE
function rapidly and repetitively injects a
specified amount at discrete intervals. Its
general form is

Under the Help menu is a file called
Equation Help. It lists a// of Berkeley
Madonna’s built in functions. You can drag-
and-drop a template onto the equation
window. The PULSE function has the form:

PULSE(V, f, r) = Impulses of volume v, first
time f, repeat interval r.

There is a bug in Berkeley Madonna that
prevents using a pulse at t = 0, so use any
value > 0.

PULSE(q, first, interval )

12
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Where ¢ is the total amount that is delivered, first is the time of the first pulse, and inferval is the
interval between pulses.

You now have a generic one-compartment model that has been applied to hundreds of drugs whose
parameters are tabulated in standard references.

FAthY

Dose Intervall  ¥d C ke

To deliver a single pulse, use the PULSE function with an interval > STOPTIME. For example, set
interval = STOPTIME +1. Select the Parameter Window under the Parameters menu to be certain that
STOPTIME = 10 and run the model. You should get a single injection at the beginning.

Now change the STOPTIME in the Parameter Window to 240 (10 days), and run the model. Use the
Pulse function to simulate different practical regimens (i.e. 1, 2, 3, and 4 times per day. The
corresponding intervals are 24, 12, 8, and 6 hours.) Set the Interval and vary the Dose to find a
dosage that, after a few days, will keep the concentration, C, within the safe-but-effective range of

10-20 mg L' Madonna’s sliders offer a convenient way do that.

Open the Define Sliders dialog (in the Parameters menu), double click on dose to add it to the
Sliders list, and then click OK. Move the slider back and forth: when you release the mouse,
Madonna automatically runs the program with the current parameter value shown on the slider. See
Help>How Do I >Define and Use Sliders for details on how to tailor the slider to specific needs.

Define Sliders
Parameters: Sliders:
STARTTIME Dose -
STOPTIME >> Add >> ©Linear
DT . Logarithmic
DTOUT { << Remove << \ — i
INIT m S — Minimum: 0
kc ‘ '
vd Maximum: 200
Dose
Interval Increment: 10

/ Cancel \ E'OI(—')
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Theophylline model - Sliders

—

1ox' e v »Dose 110

(o

(4 »]

Oral Ingestion

-

Dose|

Interval kgm| V| C kel

Figure 7. Theophylline Drug Model: Oral Ingestion

So far, we have used a single, well stirred, compartment to represent the entire body. Most drugs,
including theophylline, are given orally, not injected directly into the veins. Thus they pass first into
the GI tract and then into the circulatory system. To simulate oral administration, add an additional
compartment, labeled G/, between the Dosage inflow and the m compartment. You will also need a
new flow representing absorption (labeled Eg,) between the G/ and m compartments. Choose the
flow icon, click on the GI reservoir and drag the mouse until it contacts the m reservoir. Set

Equation 6 Ex,, =k,m
where kg, 1s an absorption coefficient. Set kg, = 0.1 and run the model. Experiments with
theophylline show that its plasma concentration reaches a peak value in about 2 hours following oral
ingestion. Reset stoptime back to 10 so that you can see the details of a single injection. Then set up
a slider to adjust the value of k. so that the peak value in the model will appear at an appropriate

time. Change stoptime to 240 and find the best dose to use at different dosage regimens (1, 2, 3,and 4
times per day).

Two Compartments
Salicylic Acid

Although the last model includes an extra reservoir to accommodate oral ingestion, the lumen of the
GI tract is essentially part of the delivery system; it is continuous with the external environment and
is not considered part of the body. Following an intravenous drug injection, a single compartment
model predicts that the drug plasma concentration will decay exponentially. In a number of cases

14
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this is a good approximation, but in many others it is not. For example, Figure 8 shows measured
values of the plasma concentration of salicylic acid (an active derivative of ordinary aspirin) plotted
as a function of time following an intravenous injection of 484 mg. The plot is not a simple
exponential: it shows a relatively fast decay lasting about 25 min, followed by a much slower one,
suggesting the presence of another body compartment, or reservoir.

No runs

1 —
0.9
Figure 8. Measured plasma 0.6
concentration of salicylic acid (SA)
following an iv injection of 484 mg in Ei'-:: 0.7
man. Plasma concentrations are -
normalized by the maximum value (at = 0.6+
time = 0). <
o 0.5
B
= 0.4
4y ]
0.3
0.2 -
©.7 =

T T T T T T T T 1
0 50 100 150 200 250 300 350 400 450 500
TIME (min.)

The single compartment approximation works only if the blood circulation distributes the drug very
quickly to all tissues. However, the data in Table 1 shows that the efficiency of this distribution
varies considerably from tissue to tissue. The liver, kidney, and heart have very large blood
perfusion rates compared with resting muscle or skin or the rest of the body. Since tissues with larger
rates can be expected to equilibrate faster, we associate these tissues with the fast phase in

Figure 8 while the other tissues account for the slower decline. (The brain presents a special case:
although it has a rapid blood flow, it possesses a ‘blood—brain barrier’ that prevents most drugs from
passing through its capillary walls at an appreciable rate.)
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Tissue Region Blood Flow mL/100g /min

Liver 57.7
Kidneys 420.0
Brain 54.0
Skin 12.8
Skeletal Muscle 2.7
Heart Muscle 84.0
Rest of Body 1.4
Whole Body 8.6

Table 1. Regional Blood Flow Density (ml/100g tissue/min)

The fast and slow phase for salicylic acid can be modeled by defining two compartments (reservoirs)
in series as shown in Figure 9. The first, central compartment, consists of the plasma together with
all rapidly exchanging tissues that are assumed to be equilibrated at all times. The second, peripheral
compartment is composed of the slowly exchanging compartments. Since drugs are generally
eliminated by kidney excretion and by metabolic inactivation in the liver, the route of elimination
emanates from the central compartment.

Central Campartment 1 Peripheral Compartment 2

Figure 9. Two compartment ¢ —
model for salicylic acid (SA4). Dose \
The formula icon SA47,0rm \‘

represents the value of SA7 ol

normalized by the Dose, i.e. = “U'.L {\r
its value equals the fraction of

the original dose that appears

) k21
in the central compartment at kizl &*
any time. Q_.
k1x‘ Ejit,
]

Although it is tempting to assign specific organs to each compartment, it is usually not feasible and
the anatomical identity of the two compartments as well as their associated volumes are generally
left as abstract elements of the model. The model shown in Figure 9 circumvents the ambiguity in
the volumes by dealing explicitly with amounts (e.g. mg) rather than concentrations. There is no
problem identifying quantities in the reservoirs as amounts; this is consistent with all of the models
we have considered. However transfer between compartments as well as rates of elimination are
determined by concentration, not by amount. This is easily resolved as follows:

We expect the transfer between compartments 1 and 2 to be proportional to the concentration
difference, (C: — C2) between the compartments. If the proportionality constant is denoted by &, and
the distribution volumes of the two compartments are V;and V>, then the flow between 1 and 2,
denoted jSA4, will be given in terms of the drug masses SA4 as
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k k
Equation 7 JSA=k(C, -C,)= VSA] - vSA2 = k,,SA, — k,,SA,

1 2

where we have replaced & by two rate constants defined by k;> = &/V; and k»; = k/V>. Similarly, we
assume Ex = k,, C; to arrive at

Equation 8 Ex =k SA
where ki = ke/ V1.

Eliminating the concentrations has the advantage of reducing the number of unknown parameters;
we have replaced four unknown parameters (k, k.., V1, and V) with three (k;», k2;, and k;3).

Guess the Parameter Values

Using Equation 7 and Equation 8 together with initial conditions S4; = SA2 = 0, set up the model
illustrated in Figure 9. We will use the curve fitting routine in Madonna to find values for the rate
constants from the experimental data shown in Figure 8. To do this, we will need initial guesses for
these parameters. The time scale in the figure runs from 0 to 500 minutes suggesting that residence
times of the order of 250 min ought to produce results that change within the required range, Set &,
=ky;=k;3=1/250=0.004 min ', and run the model. Your results should look like the blue curve in
Figure 10.

Import the Data:
1. Select Import Dataset from the File menu. The

standard Open dialog will appear. z [mpoet Datnsel -

2. Open the enclosed data file called ‘Salicylic Acid’. 13rows, 2 columns
This is a simple 2 column text file; the first column Name: #]SalicylicAcid n
contains values for the x (time) axis, the second
contains y (S47) values. A dialog will appear. It @ ¥econall) —— @ Malvix ()
describes the data file, allows you to rename it, and X column: [1_]
allows you to choose which column represents the ¥ column: [2_ |
independent (x axis) variable and which represents y.
Numerical data files in Berkeley Madonna are [Cancel | ok |
distinguished by the prefix #.

3. Click OK

The data is now superimposed on the plot. The 13 data points should be represented by open
unconnected circles. If your results show data points connected by lines, then open Edit >
Preferences . Click on the Graph Windows tab and check Plot Imported Data with Circles.

Notice the large discrepancy between the data and the model run with the guessed parameters.

Find the Parameters by Curve Fitting the Data:

1. Click Curve fit in the Parameters menu to bring up the dialog shown below.
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2. Double click on the unknown parameters k>, k2;, and k. in the Available: list to move them over
into the unknown Parameters list.

3. Use the Fit Variable pull down menu to select S41,0/m.

4. Check that #SalicylicAcid is entered in To Dataset.

5. Click OK.
Curve Fit

Available: Parameters:
INIT SA1 k12
INIT SA2 ™ >>Add>» | k21 Minimum:
k12 kix
K21 Guess #1: |0.002
kix
Dose Guess #2: 0.006

_[J Multiple Fits: :
Fit Variable: | SAlnorm $)|[ »Add>»
To Dataset: [#SalicylicAcid i] | <« Remove << | —

[ Import Dataset... ]
Weight: I:l

Tolerance: |Cancel| | 0K |

Madonna runs the model repetitively. New parameters are generated for each run until a “best fit” is
found. The final run , using the best fit parameters, is then automatically displayed on the graph.
(When comparing the curve fit to the data on the graph, be certain that both data points and curve fit
are scaled on the same y axis.) Parameter values used in the plotted curve fit can be found in the
current Parameter window. Or, as in Figure 10, simply click on the P button (on top of the graph) to
place a moveable window that lists all parameters onto the graph.

These new parameter values provide a ready interpretation for the biphasic shape of Figure 8. The
rate constants k;, and k;; for transfer between central and peripheral compartments are an order of
magnitude larger than kix ( the rate constant for elimination of the drug); in other words
equilibration between compartments is much faster than elimination. The fast phase in Figure 8
reflects the rapid equilibration as the injected drug moves from central to peripheral compartments,
while the later slow phase corresponds to the slow elimination.
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*
Aspirin
Our model for salicylic acid provides one part of the more complex model for aspirin (acetyl
salicylic acid, 45S4). When 4S54 enters the blood plasma it is rapidly hydrolyzed into salicylic (S4)

and acetic acid by esterases contained in both blood and tissues. Both S4 and AS4 are effective
analgesic, antipyretic, and anti-inflammatory drugs (see Error! Reference source not found.)
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SALICYLATE EFFECT
CONC (mg/dL)
pain relief
0-10 fever relief

platelet inhibition
gastric intolerance

10- 50 anti-inflammatory
50 - 80 ears ring
hyperventilation
80-110 Fever
Dehydration
acidosis
110-160 coma

vasomotor collapse

>160 FATAL
respiratory and renal collapse

Figure 11 Pharmacological Effects of SA and ASA

Our model for an iv injection of aspirin is shown in Figure 12. If 4S4 was not transformed into S4,
their models would be almost identical. However, the transformation is rapid and irreversible; it
provides the principal route J3; for elimination of ASA (elimination by other means, e.g. excretion,
are negligible compared to J3; so they are left out of the model). Save a copy of your S4 model and
then use the original to build the aspirin model below.
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ASPRIN Central Compartment 1 Peripheral Compartment 2

jASA

L'_OH , "J A5A 1 4542
Figure 12 —ﬂ—%
! > / \
k34
r/ /ASAInorm J31 ‘ k43
o o Dose
| .

OH——C——CH, C—0" SA1norm

ACETICACID OH

SALICYLATE

Fit the Two Curves Simultaneously

Import two files of experimental data entitled ASA.dat, and SA.dat from the CD. These data,
resulting from a Dose = 650 mg, were not obtained from the same subject as the data of Figure 10.
So parameters obtained from that data are not particularly applicable. Instead, we will employ the
curve fitting routine to obtain all six unknown parameters. k;2, k2;, k34, kq3, kix, and k3;. To acrry this
out, set all initial values = 0, Dose = 650 mg, and use the same nominal guess of 0.004 min™ for all
six rate constants (k;,= k2= kz4= k3= k1= k3; = 0.004). Run the model.

As in the salicylic acid model, bring up the Curve Fit dialog by clicking on Curve Fit in the
Parameters menu, and load all six rate constants into the Parameters list. Since we will be looking
for several parameters, it is a good idea to place restrictions on permissible values. In this case we
will simply require all values to be positive by selecting each parameter in the list and setting its
minimum value = 0 (upper right hand corner of dialog) . To fit more than one curve simultaneously
check the box entitled Multiple Fits (center of the dialog). Then select ASAn from the Fit Variable
popup and select the corresponding data, #4SA4dat from the To Data Set.Click the ADD button to
move the pair to the list on the right. Do the same for SAn and #SAdat . The Multiple Fits list should
now show ASA4n : #4SAdat followed on the next line by S4n : #Sadat. Click OK. After the program
finds a best fit to the data, your results should look like. Figure 13. Again, make certain that the data
and corresponding curve fit are scaled on the same axis (Use shift-click on the variable button qt the
lower edge of the graph to toggle the scaling axis)
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Figure 13.

#ASADat, #SADat, ASA1n, SA1n

0.2,

120
TIME

The model fits the data remarkably well. However this result is less impressive when we
acknowledge that six independent parameters were adjusted to secure the best fit. This is but one
example of a common dilemma: realistic biological models generally have large numbers of
parameters whose values are not known; the larger the number of unknown parameters, the more
difficult it is to establish validity or utility of the model. Confidence in the model increases when the
range of data it accounts for increases. In our aspirin model, for example, it would be desirable if the
same set of rate constants would predict the systems response to a wide range of doses. In addition,
confidence increases when physiological rationalizations can be offered for the values of the fitted
parameters. In the case of two compartment models, the abstract, ill defined, nature of the
compartments precludes much success. Multi-compartment pharmacokinetic models that address
these issues are known as physiologically based pharmacokinetic models.
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Physiologically Based Pharmacokinetics

Physiologically based pharmacokinetic (PBPK) models model anatomical structures (usually organs)
with compartments. This requires taking account of regional blood flow as well as the interaction of
the drug with each tissue. We illustrate with a model of benzene, an industrial toxin. The most
significant pharmacological features of benzene are:

1. Itis volatile and its vapor gains access to the body via inspired air.
2. Itis highly soluble in fat and tends to accumulate in fatty tissue.

3. Itis removed from the body primarily through metabolism in the liver.

In the simplest model that accounts for these properties considers only 3 tissues in addition to the
blood: fatty tissue, non-fatty tissue, and liver. The amount [in mg] of benzene within each of these
tissues will be represented by a reservoir with a prescribed volume. Our task is to account for the
flow of benzene into and out of each of these four compartments. First consider how the non-fatty
compartment exchanges benzene with the blood compartment, as shown in Figure 14.

. Benzene in Blood Benzene in non-fatty tissue
Figure 14 Benzene Flows

from Blood to Non Fatty ]

nf
Tissue.
C A ¢ Cnf\

Vb Onf Yof

Blood flows from the blood compartment, B, to the non-fatty tissue compartment, NF, at a rate O,
[L-hr']. Benzene, at blood concentration Cj [mg-L™], flows into the NF tissue at rate Oy *Cp.
Benzene returns from non fatty tissue back to the blood at a rate O, * Cy5, where C,, is the
concentration at the venous end of the capillary. However, the lipid soluble benzene permeates
membranes rapidly, so we can assume that by the time blood traverses a capillary, the benzene has
equilibrated with the tissue. This means that C,s = C,r where C,is the tissue concentration. Letting
Juy denote the net flow between blood and tissue:

Equation 9 J,=0,C,—-0,C, = an(cb - Crgf)

Concentrations are computed by dividing the amount in the reservoir by the relevant volume as
shown in Figure 14.
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We modify this basic element to model the other tissues, and connect them through the blood supply.
This yields the four compartment model shown in Figure 15.

NF|
Jnf -
> Non Fatty Tissue
'\Q‘ Cnf
Ui Vinf

Figure 15 Four
compartment ;ﬂv «

i

i .
>r Fatty Tissue

N

Cf
benzene Model. Pb) tﬂ [t [
|
ﬂJ m Y IMax

The structure for the fatty tissue compartment, F, is very similar to that of the non-fatty tissue
compartment, NF, but modified to account for the high fat solubility of benzene as follows. If the
concentration in venous blood ,Cjy, is in equilibrium with the tissue concentration Cy, then Cs, = C/Py
where Pris the solubility of benzene in the fatty tissue.

The structure for the liver tissue compartment is similar to F, but with an additional outflow to
account for the enzymatic processes that remove benzene from the liver. We shall model this rate by
a saturating curve similar to that of a Michaelis-Menten enzyme:

J

metab

C
Equation 10 J ooy = I;”“%é
m l
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Finally, to represent the net uptake of benzene by respiration an inflow is added to the blood
reservoir. Denote the ventilation rate by Q,..., and let C; be the concentration of benzene in inspired

air. Then benzene enters the lungs at a rate Q.. -C;. Assuming exhaled benzene is in equilibrium
with blood, it will exit the lungs at a rate QyenrCb/P), where Py is the blood/air partition coefficient.
The difference between entry and exit must represent the rate of uptake of benzene so that J,., is
given by

C

: _ b
Equation 11 Jep =0, [Ci - Fb]

Typical parameter values for mice are given in Table 2

Alveolar ventilation rate [L hr'']

Benzene concentration in inspired air [mg L]
Initial condition blood

Initial condition fat

Initial condition liver

Initial condition non-fat

Michaelis-Menten constant [mg L]
Blood/air partition coefficient

Fat/blood partition coefficient

Liver/blood partition coefficient

Blood flow to fat [L hr'']

Blood flow to liver [L hr'']

Blood flow to non-fat [L hr'']

Volume blood [L]

Volume fat tissue [L]

Volume liver tissue [L]

Maximum velocity of metabolism [mg hr'']
Volume non-fat tissue [L]

Table 2 Parameter for Benzene Model for Mice

Construct the model and simulate a 48 hour exposure of air containing 0.32 mg-L™' of benzene.
Compare the level of benzene as well as its equilibration times in the different tissues, and relate
these to the tissue’s solubility and blood flow.

Simplifying the Flowchart: Aliases, Sub-models, and
User Defined Icons

As models grow, more complex, the flow chart becomes messy; the inevitable clutter obscures the
simple elementary relations that generate the model. Berkeley Madonna uses several devices to
simplify the flowchart, illuminate the basic structure of the model, and to make icons more reflective
of their context. These devices include aliases, submodels, user defined icons, icon visibility, and
user defined back-grounds.
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Aliases

Complex models begin to resemble a bowl of spaghetti
when connections are required between two icons that are =
spaced far apart. Rearranging icons is time consuming and Alias of R1
rarely produces a simpler flowchart. An alias icon is one —>
solution to this problem. You create an alias for one of the

icons and place it close to the otherwise distant icon, and .

then connect the alias to the target icon with a short R1 R1
connection. The alias icon looks like a ghost version of their R e B
original and it provides another way to access the original .

Double-clicking an alias opens the icon dialog for the original. When connections are made to an
alias, the effect is identical to that resulting from making the same connections to the original. The
most important thing to remember is that an alias always refers to an original.(You can
locate the original by selecting an alias and choosing Find Original from the Flowchart
menu).

To create an alias, select one or more existing icons and click the alias button in the toolbar.
Berkeley Madonna will create one alias for each icon you selected. However, note that
aliases will only be created for reservoir, flow, and formula icons. You can create as many
aliases for a particular original as you want by repeatedly clicking the alias button. These
aliases can be placed anywhere in your flowchart. An alias always has the same name as
the original. If you change the name of an alias, it changes the name of the original and all
of its aliases. If you double-click an alias, it opens the icon dialog for the original.

Figure 16 shows a different representation of the benzene model shown in Figure 15. Here aliases
have been used for B and for CB. The flowchart allows for easy comparison of the tissue variations
involving solubility and metabolism. To add more tissues to the model simply select one of the
tissue types (including all its connections) and copy and paste it into the diagram. (Be careful to
reposition the pasted objects before de-selecting them.) Finally rename the icons where appropriate.
Although the simplification in Figure 16 may not be dramatic, similar alias simplifications become
very significant in more complex cases. Further, aliases are an essential component of sub-models
described below.
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Figure 16 Benzene Model with Aliases.

Hierarchal Sub-models

Although aliases can help make complex models easier to construct, as models continue to grow,
there simply isn’t enough room in a single flowchart window to contain all elements. And even if it
were possible to cram an entire model into one full-screen window, it would difficult to see its
overall structure through the forest of arcs, flow lines and icons.

Berkeley Madonna allows you to break your model down into functional parts by placing them in
submodels just as you would place related groups of files into a folder or directory on your
computer. Submodels appear as icons in your flowchart. The flowchart containing a submodel icon
is referred to as the submodel’s parent flowchart. When you double-click a submodel icon, a
separate flowchart window is opened showing the contents of that submodel. Figure 17 shows an
application of sub-models to the Benzene Model of Figure 15.
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Notice that submodels can be imbedded in each other; i.e. a submodel can serve as the ‘parent’ for a
deeper level submodel.

Creating Submodels

You will find that Flowchart models with more than a few reservoirs and
functions quickly become a spaghetti whose structure is obscured by the clutter.
The answer is to use Submodels, which are analogous to subroutines in a

programming language. Submodels can be created in several ways. To create a

new, empty submodel, you can click the submodel tool

drag the mouse over the flowchart and release it. Berkeley Madonna places a new submodel icon on
the flowchart.

More often, new submodels are created from icons that already exist on the flowchart. This is
accomplished by selecting the icons and choosing Group from the Flowchart menu. Berkeley
Madonna creates a submodel icon on the flowchart and places the previously selected icons inside
that submodel. When icons are moved into a submodel, aliases are created in order to preserve the
connections that existed before the submodel was created. Double- clicking the submodel icon
allows the user to edit its contents in the same way as the top-level flowchart.

Try transforming your model as depicted in Figure 15 into the model shown in Figure 17. A simple
way is to begin by selecting the NF reservoir and then choosing Group from the Flowchart menu.
Name the sub-model icon Non Fatty Tissue and then, one by one, drag the associated icons JNF,
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CNF, VoINF, and ONF and drop them on the sub-model. You can accomplish the same task in one
operation by choosing Group after selecting all the relevant icons (either by shift-clicking or by
drawing a marquee around them with the selection tool)

Deleting a submodel icon, deletes not only the icon but also all of the icons it contains. However, it
is possible to delete a submodel icon while preserving the icons and connections it contains by
selecting one or more submodel icons and choosing Ungroup from the Flowchart menu. Berkeley
Madonna removes the submodel icon and moves all the icons it contained into the parent flowchart.

Making Connections between Submodels

Icons may be moved from one submodel to another in two ways: First, you can move a set of icons
from a flowchart into one of its submodels (children) by dragging the icons to the submodel icon and
dropping them inside. Second, you can move a set of icons from a submodel into its parent flowchart
(the flowchart containing that submodel ’s icon) by selecting the icons and choosing Move To Parent
from the Flowchart menu Try moving some of the icons back and forth from parent (main) to child
(submodel) window.

User Designed Icons

Flowcharts can be made even more intuitive by replacing the default, generic icons with
icons that are designed to reflect the object that each represents. This is illustrated in Figure
18 which shows a customized version of the our benzene model. Note that the new images are
not simple paste- overs, they are bona fide icons with the same functionality as the originals. They
can be moved about freely and functional connections can be added or removed. Double clicking on
the icon initiates the same action as clicking on the original.

Icon replacement is implemented by first preparing an icon in a paint/draw program and saving it in
either GIF or JPEG format. Next select the icon in your model to be replaced, and then select the
Import Icon Image command (Flowchart menu). An ordinary open dialog will appear allowing you
to select any GIF or JPEG image . Clicking Open in the dialog will replace your selected model icon
with the new custom image (selected in the dialog) from an external file. (The Import Icon Image
command is available only when one or more model icons are selected.)

Figure 19 shows a more elaborate model of the same problem. Here, the visual advantages
provided by context sensitive images are even more apparent. They allow the features of a
complex model to be grasped with a single glance. In this version we have combined the
flows and associated icons into submodels (replacing their image with faucets) while
keeping the reservoirs intact (but, replacing the generic icons with anatomical ones).

A set of Icons designed for PBPK models is contained within a folder on the Madonna disk.
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Figure 18 Benzene Model with User Defined
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Respiration

Applications and Limitations of PBPK models

Defining a detailed and explicit physiological basis for the distribution of drugs is more satisfying
than a more formal abstract compartment approach. It is particularly useful and has found wide
application in cases where the location of the drug is critical, e.g. models for anticancer drugs as well
as in toxicology studies. In some cases, e.g. when dealing with CNS drugs, the permeability of the
vascular bed is also taken into account. However the models are complex and depend on large
numbers of parameters. Many of these parameters are only measured with invasive techniques,
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which are not applicable to humans. In these cases we rely on extrapolating data obtained from
animal studies. Guidelines and empirical rules for interpolating or extrapolating PKPB parameters
between species are reviewed by REF XXX.

Population Pharmacokinetics (Monte Carlo Simulations)

Even when we have good “normal” values for the parameters, we still may want to account for
individual variations. Environmental Toxicologists, for example, are continually confronted with
problems that require some estimates of risk associated with pollutants. These are often expressed in
statistical terms — e.g. what percentage of the population can be expected to have high levels of
pollutant in specific organs when they are exposed to a given pattern of pollutants. We can attack
this problem by running the same model over and over while each repetition draws a random
estimate of each parameter. We illustrate with the benzene model:

Pharmacodynamics
Receptors

Computing the concentration of a drug at its target site (pharmacokinetics) is a first step. It solves the
drug delivery problem, but it does not address the mechanism of drug action. A more complete
theory would integrate the action of the drug with a model of the physiology of its target cell (e.g.
See chapter xxx on the action of a local anesthetic). But cellular models is a diverse subject, and so,
unlike pharmacokinetics, pharmacodynamics does not lend itself to a simple general treatment.
However, most pharmacodynamic models consider the binding of ligands (e.g. drugs or hormones)
with receptors as the first step. The relation between free and bound ligand concentrations follows
simple chemical principles. Letting L represent free ligand, R free receptor, and LR ligand -receptor
complex, we write L + R— LR.

Here, we make the simple assumption that the ligand receptor reaction is so fast that it is virtually in

equilibrium at all times. More general cases will be discussed later. Let K59 denote the equilibrium
(dissociation) constant, then

Equation 12 Ky=—=

Letting [Rt] denote the total concentration of both free, R, and occupied, LR , receptors
Equation 13 [R.|=[R]+|[LR]

Eliminating [R] from the last two expressions, we can solve for [LR]. Then letting C = [L], and
defining p = [LR] / [R7] as the fraction of receptors occupied by the ligand we have

_ C
K, +C

Equation 14 p

The value of p varies between 0 (all receptors free) to 1 (all receptors occupied)
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Note that in the special case where 50% of the receptors are occupied, p = 1/2 and C = Ksy. Hence
the notation: aside from being a dissociation constant, K, is numerically equal to the concentration
where 50% of the receptors are occupied.

Just how the physiological response of the ligand depends on the number of occupied receptors will
differ from case to case. In the simplest examples, the physiological effect E is proportional to the
number of occupied receptors. If a is the proportionality constant then, since the actual concentration
of occupied receptors is [R7] p,

Equation 15 E= a[RT] )4

If the maximal physiological activity, E,.., occurs when all receptors are occupied, i.e. when p =1,
then E,,.x = a [Ry] and

Equation 16 E=FE  p=FE

activation
" K,+C ( )

Equation 16 implies that the drug is stimulatory, i.e. it enhances the activity. On the contrary, many
drugs are inhibitory; they work by blocking receptors. In this case we assume that E is proportional
to the unoccupied receptors. The fraction of unoccupied receptors is given by 1-p and in place of
(12) we now have

E_.K
Equation 17 E=E,_ (1-p)=—22"C (inhibition)
K,+C

Note in this case, the maximum activity now occurs when p = 0 (and C = 0)

Figure 20 shows plots of E for various values of C. As expected they show that the plots rise (fall)
asymptotically to a maximum (minimum). This behavior is often called saturation, e.g. at high ligand
concentrations the receptors become saturated with ligand. Saturation is probably the most common
source of non-linear behavior in biological systems.
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Sigmoidal Response

The curves depicted in Figure 20 are rectangular hyperbolae; they rise (fall) abruptly with the
steepest slope at the origin. When activation or inhibition of a receptor requires binding of more than
one ligand, this behavior changes and the curves assume an S or sigmoidal shape where the curve is
flatter near the origin (see Figure 21 and Figure 22). If we change the stoichiometry in our reaction
by requiring » ligands for each receptor: nL. + R — L,-R. Using the same arguments as before, we
arrive at the following analogous expressions for activation and inhibition respectively.

Equation 18 E= Lol
quation = Ki +C"
EmaxKSnO
Equation 19 =T Lo
quation K., +C

These are plotted in Figure 21 and Figure 22. Again, E,,,, and K5 indicate the maximum effect and
the concentration where E = 1/2 E,,,4;.
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Figure 21 Plot of Equation
18 with Ks5p= 2, Ejax =100
andn=1, 3, 5. Again, all
plots cross the 50% level at
C= K5() =2.

Figure 22 Plot of Equation
19 with Ks5p= 2, E 0 =100
andn=1, 3, 5. All plots
cross the 50% level at C =
K5() =2.
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The reaction implies that » molecules of L react simultaneously with R. Even with n =2, this is
highly unlikely. A more accurate formulation would characterize the reaction taking place in stages

1.€.

L+R—>L1R

L.R+R——>L;R

Ln-lR +R——> LnR

Our simplification of writing the reaction in a single step essentially assumes that intermediates are

short lived with only negligible amounts present at equilibrium. This appears to be the case in many

proteins which bind ligands cooperatively, e.g. hemoglobin binding of oxygen (refXXX).
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Combining Pharmacokinetics and Dynamics
Steroid Regulation of Cell Trafficking: A Direct Response

Once a pharmacodynamic system is constructed, it is fairly easy to add a pharmacokinetic regime for
a more complete model. To illustrate we consider models developed by Jusko et.al. to describe some
physiological responses to doses exogenous steroids (refsXXX) The simplest describes the
movements of histamine containing white blood cells (basophils) between vascular and extra-
vascular (tissue) spaces. Basophils are assumed to enter the blood stream at a constant rate and to
leave at a rate proportional to the number contained within the circulatory tree. Exogenous steroids
are assumed to inhibit the rate of entry by reacting with a steroid receptor.

Following the injection of the steroid, methylprednisolone, data were obtained from measurements
of methylprednisolone and histamine in the blood. Since more than 97% of blood histamine resides
within basophils, it follows that blood histamine concentration is proportional to basophil count.
Rather than following basophils directly, it is more convenient to measure histamine and this is
reflected in the model shown in Figure 23.
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The lower sequence is a simplest model for passage of basophils between vascular and extra-
vascular spaces. It is assumed that the extra-vascular space is an infinite source for basophils so that
we need only account for the basophils ( amount of histamine ) in the vascular compartment. This is
represented by the H reservoir which, as usual, reflects the initial amount present as well as the Enter
and Exit flows. The Exit flow is proportional to the histamine concentration (density of vascular
basophils). If C,= H/V), denotes the histamine concentration and k;, denotes the proportionality
constant, then

Equation 20 Exit=kh *Ch.

But, the Enter flow contains the link to the steroid concentration Cs. It is assumed that this rate is
inhibited by drug interacting with an unspecified receptor. Let p represent the fraction of receptor
sites occupied by the drug and let baseRate denote the rate of entry in the absence of inhibitor, then
(see occupied by the ligand we have

Equation 14 and Equation 17 with E,,,. = baseRate)

Cs
Equation 21 =—
duation P= K50+ Cs
Equation 22 Enter = baseRate(1 - p)

The top sequence in Figure 23 is a one compartment pharmacokinetic model with parameters listed
in Table 3. Flows are similar to earlier one compartment models e.g. Figure 6.

Steroid
Init Steroid | 0 Exogenous Steroid (1g)
Dose 4E04 Injection dose (pg)
Interval IE06 Time for “second injection” (hr)
k 24 Steroid clearance (L hr'")
vd 90 Volume of distribution (L)

Histamine

Init H Ho Initial histamine content (ug)
Ho 90 Initial histamine content (pug)
baseRate 30.6 Uninhibited rate of histamine entry (ug hr'")
kh 1.7 Clearance rate constant for histamine leaving the circulation (L hr'")
Ko 3 Dissociation constant for Steroid-Receptor (ug hr'')
12 5 Blood Volume (L)

Table 3. Cell Trafficking Model: Parameters for 70 kg Human

Set up the model and run it, plotting Ch (scaled on the left) and p (scaled on the right). Overlay each
response for dose levels of 10, 20, 40, and 80 E04 png. Note how the proportionality between dose
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level and response that was evident in the earlier models has disappeared as receptor becomes
saturated at higher doses.

To compare the time course of drug dose remaining in the body with its effect on histamine content
of the blood, it is convenient to normalize the plots and define the effect more precisely in terms of
histamine depression. To do this, place two new formula icons on the flowchart, label one
steroidPercent, the other hlinhibition. Connect an arrow from Steroid and another from a Dose to the
first icon. Connect an arrow from H and Ho to the second icon. Remembering that initially H =Ho
mg L™, double click on the icons and enter the following:

Steroid
Equation 23 steroidPercent =100 # >
Dose
Equation 24 hinhibition =100 *[H (}1_ H j
0

Reset the Dose to 4E04 and run the program. Replace the plotted variables with steroidPercent and
hlinhibition. Note the discrepancy between the two curves; by the time the inhibition is at its
maximum of about 92% (i.e. at about 10 hours), the steroid has fallen to less than 10 % of the
original dose. Plotting p shows a major reason for this large discrepancy. At 10 hours, the receptors
are still nearly saturated. The saturation which is apparent at the beginning persists because the large
injected dose created an initial concentration (Dose/Vy= 4E04/90 =440 pg L' ) much larger than
Ks=3 ng L, so even though C declines rapidly there is still enough to keep the receptors near
saturation. Receptor occupancy will decrease to 50% only when C falls to 3 pg L™.

But, even if the original dosage were reduced, there would still be a discrepancy because the steroid
does not act directly on the vascular H pool. Rather, it acts on how fast the pool is replenished from
extra-vascular sources, and it takes time for any rate change to exert its full effects on the pool.
There is an inevitable delay whenever a dynamic process intervenes between cause and effect. The
next model provides a more dramatic example.

Steroid Regulation of Enzyme Synthesis: A Gene Mediated Delayed
Response with Down Regulation

Glucocorticoids, secreted by the adrenal cortex, are essential steroid hormones with diverse
functions: They facilitate the action of other hormones, or they take part in the long term adaptation
to stress. These latter functions include the mobilization of amino acids from labile protein reserves,
the synthesis of gluconeogenic enzymes to promote the conversion of proteins to glucose, and the
trafficking of white cells. In chronic stress, excess glucocorticoids can be harmful causing atrophy of
lymphatic nodes, decreased immunity, hypertension, and other vascular disorders.

Glucocorticoids are used in higher concentrations as drugs because of their immunosuppressive and
anti-inflammatory actions. Some administered glucocorticoid effects (e.g. synthesis of enzymes) are
gene mediated and, following a single dose, may only appear after the drug has dissipated. The
following model (ref XXXX) accounts for the gene mediated effects of the glucocorticoid drug.
methylprednisolone, on the synthesis of a gluconeogenic enzyme called TAT (tyrosine-amino
transferase, an enzyme that catalyzes the cleavage of amino groups from tyrosine making the residue
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available for glucose synthesis.) In addition to exhibiting a delayed response, the system becomes
desensitized to repeated doses, a behavior attributed to receptor down-regulation. Both of these
features, delay and desensitization, are accounted for in model of Figure 24.

Figure 24 . Basic Scheme of Steroid
Model (REF). Symbols are: D = Drug
(methylprednisolone), R = Receptor
(cytosolic), DR=Drug/Receptor
complex(cytosolic), DR, =
Drug/Receptor complex(nuclear),
mRNA-R = messenger RNA for
Receptor, nMRNA-TAT = messenger
RNA for TAT, TAT = enzyme (final
product of gene medziated response to D+R
steroid) DR, is assumed to stimulate J
production of mRNA-TAT, and to

feedback and inhibit production of

mRNA-R. Downward pointing arrows

represent normal degradation.

Steroids, in general, are lipid soluble and easily pass through cell membranes. When the steroid D
enters the cytosol it reacts with a receptor protein R forming a complex DR that is transported into
the nucleus where it has two effects:

1. It binds to DNA control sequences adjacent to the target gene. Transcription is stimulated
producing more mRNA-TAT to be transported to the cytosol where translation and production
of the final protein 74T increases.

2. It inhibits transcription of mRNA-R thereby cutting back on the rate of synthesis of new
receptors. This negative feedback will reduce the rate that DR, can be formed and accounts,
in part, for the receptor down regulation.

The model takes into account that both mRNA-TAT and mRNA-R are perturbed from their normal
steady state by the action of DR,. In turn this perturbs the steady state of both 747 and R. To
accomplish this it is necessary to account for rates of production and degradation of the messenger
RNA variables mRNA-R, and mRNA-TAT, as well as R, DR, DR,,, and TAT.

Parent Window

Implementation of the model in Madonna is shown in Figure 25 to Figure 28. It contains a main
parent window with the D-R cycle (shown in black Figure 24) and three submodels (shown in blue)
for Steroid pharmacokinetics, Receptor mRNA synthesis, and TAT synthesis.

The model can be constructed by duplicating Figure 25, dragging each submodel icon from the
toolbar. To make connections to the submodel icons, make an alias of the icon to be linked and drag
the alias into the submodel icon. Then double click on the submodel icon to open its window and
duplicate its contents as shown in the figures below.
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Normalize the Variables

To get a good overview of the model it will be expedient to plot and compare behavior of the major
variables D, R, DR, DR,, TAT,,, and TAT on the same graph. Using concentrations, this is not
feasible because the variables do not have a common scaling. Some are in the fmole range while
others are measured in nmoles. We can provide a workable scaling by normalizing variables to their
initial concentrations. Denoting concentrations with conventional square brackets, and letting the
subscript o denote initial values, we define our new normalized variables as:

. [TAT]
E 2 TAT =
quation 25 [TATO]
Equation 26 TATm = M
a "= [TATmo]
. R
Equation 27 Rm= [[RnTo]]

The Drug-Receptor complexes DR and DR, have initial values equal to zero. However they are
simply different forms of R, so we use Ro for all three

. [R] DR [ DRn]
E 2 R=——= DR=— DRn=
quation 28 [Ro] Ro n ko]
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The drug concentration, D, is also zero at starttime, so we normalize D by it’s concentration Do
immediately following the injection. At that time the drug mass ,mDo, is equal to Dose, making

mDo B Dose

Equation 29 [Do]= vd - vd
and
. [D] vd=|D]
Equat D= =
quation 30 [Do]~ Dose

Note that for normalized variables. the distinction between concentration and mass vanishes. This
follows because they are proportional i.e. if mD is the mass of drug, then initially we have mDo =
[Do] *Vd, and at any later time we have mD = [D]*Vd. Dividing the first equation into the second
leaves

[D] mD

Equati 1 D= = =
quation 3 [Do] ~ mDo m

where m is the normalized mass.

Finally it will be helpful to keep track of all receptor molecules, regardless of their location or the
presence of bound ligand. We define this total as

Equation 32 Rtot= R+ DR+ DRn

Normalized variables requires redefinition of parameters

Our normalized variables have no dimensions, they are pure numbers. Yet, we use them in model
building as though they are the original non-normalized variable. For example, the law of mass
action relates the rate of a reaction to the product of concentrations, not the product of numbers. In
our model we apply this law to the binding of D to R with the binding rate given by

Equation 33 rate= k *[ D] *[R]
In terms of our normalized variables this becomes

(D], IR]

*

[Do] [Ro]

=kl*D*R

Equation 34 rate= k *[ Do]*[Ro] *

where kI = k*[Do] *[Ro].

In general, by multiplying and dividing individual terms by the same number, we can always use
normalized variables as though they were the original non-normalized quantity provided we absorb
normalization factors within the parameters. (Sometimes normalization factors will occur on both
sides of an equation and cancel so that some parameters may not change - see pp XXX.) The
parameters in Table 4 have been adjusted for normalizations defined by Equation 25 to Equation 32.
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Define the Model Flow Rates

Flow rates in the cycle of the parent chart (Figure 25) are calculated from the law of mass action. In
the equations that follow. all parameters beginning with & are rate constants for the cycle, all
beginning with a are synthesis rate constants, and those that begin with b are degradation rate
constants. The flows in Figure 25 are given by:

Equation 35 Binding= kB XD X R

Equation 36 Transport = kT X DR

Equation 37 Recycle= fR * kre* DRn
Equation 38 DegDRn = (1- fR)x krex DRn
Equation 39 DegR=bRX R

Equation 40 SynR = aRx Rm

where, fR is the fraction of dissipating DR, that gets recycled to the cytosol as free R, and R,, is the
amount of messenger RNA coded for R as calculated in the subprogram Receptor mRNA (see
below).

Numerical values for parameters are listed inTable 4.

Steroid Submodel

The submodel entitled Steroid is a simple generic one compartment model:

x|
-~ [

Figure 26 One compartment

model for steroid Dose Intervall
pharmacokinetics. It is linked k«
to the parent window with its ke|
attachment to the alias for the o
Binding flow as well an
attachment of Do to kB .

,Do! ,Blndlng,
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Here D stands for normalized drug concentration, and m represents the normalized mass of the drug
in the body. The injection pulse is divided by the Dose to normalize m. Do (bottom left of flowchart)
is the same as [Do], i.e. it is the initial non normalized drug concentration. It’s value is required by
kB

Relevant equations are:

P D L1
Equation 41 Inj= ulse(Dose,1,1000)

Dose
Equation 42 Ex=kc*D
Dose
Equation 43 Do =
quation 0=

In addition, Equation 31 gives D = m. The aliases. kB and Binding, are defined in the parent
window.

Receptor mRNA Submodel

Ksal
o

aRm| )
Rm
b d
L Deg Rm
bRm| 5
=l

O

SynR

Figure 27. Receptor RNA
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It is assumed that R,, is normally produced at a constant rate that is inhibited by DR,. Binding of DR,
to this control site occurs with dissociation constant = K5y so that

DR
Equation 44 SynR, = aRm X [1 - Kso"'—an]

Degradation of R, is assumed proportional to R:

Equation 45 DegR, = bRmx R,

TAT Synthesis Submodel

aTAT|

1%
T
-5

Figure 28. kdeg Tm ‘> Deq TAT I >
TAT Synthesis : \ ' v\
¢ bTm o
]

bTAT

Equation 46 SynTAT = aTAT * (TAT, )"

The exponent g is an “amplification factor” introduced because the 747 synthesis rate is very
sensitive to TAT,, , rising faster than a simple linear dependence on TAT,,.

Equation 47 DegTAT = bTAT x TAT

We assume TAT,, is normally produced at a constant rate a7, that is stimulated by DR, and
stimulation is proportional DR, with proportionality constant, s.

Equation 48 SynTm= aTm X (1+ sX DRn)

Equation 49 DegTm =bTm X TAT,,

43



PHARMACOLOGY

Getting Parameters from the Steady State

This model has its share of parameters, but they are not all independent. Before the first injection
takes place, we assume our system is not changing ; it is at “rest”. More precisely the system is in a
steady state where variables such as R or 74T remain constant because their rates of production are
balanced by their rates of degradation. In our terms the flows in equal the flows out.

Beginning with R, we find three relevant flows Binding, SynR and DegR . At time = 0 (starttime),
Binding = 0 because D = 0, so the SynR inflow has to equal the DegR outflow. But, using the initial

normalized values (Equation 27 and Equation 28) we have R =1 and R,, = 1. It follows from
Equation 39 and Equation 40, that

Equation 50

Now consider R,,. At time =0, DR, =0 and R,, =1. Setting the inflow, SynRm, equal to the out flow,

aR =bR

DegRm,, we have from Equation 44 and Equation 45,

Equation 51

Flows for TAT and TAT,, are handled the same way. At time = 0, both TAT and TAT,, equal 1 and

aRm= bRm

DR, = 0. Setting inflow = outflow for both, we use Equation 46 to Equation 49 to arrive at

Equation 52

Equation 53

aTAT =bTAT

aTm=bTm

The assumption of a steady state at time = 0 is a common practice for reducing the number of
independent parameters. We will use it repeatedly.

VARIABLE VALUE DEFINITION AND UNITS
INIT R 1 Initial Receptor Conc. ( number)
INIT DR 0 Initial cytosolic Drug-Receptor Conc. (number)
INIT DR, 0 Initial nuclear Drug-Receptor Conc. (number)
kB 0.0039*Do | Binding rate constant ( hr' )
kre 0.57 nuclear Drug-Receptor recycling/degradation constant ( hr'')
rF 0.49 Fraction of disappearing DR, that is recycled to free R (number)
kr 0.63 Transport rate constant for DR from cytosol to nucleus (hr™)
aR =bR Rate constant for R synthesis (hr™") --obtained from steady state
bR 0.0572 Rate constant for R degradation ( hr )

STEROID subprogram
ke 1.32 Normalized Steroid Clearance (hr™)
vd 0.27 Volume of distribution (L)
Dose 5E03 Amount injected (nmole)
Interval 1000 Time for second injection (hr)

RECEPTOR mRNA subprogram
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INIT R, 1 Initial R,, concentration (number)
aR, 2.9 Rate constant for R,, synthesis (hr'")
bR, = =aR, Rate constant for R,, degradation (hr' ) --obtained from steady
state
Ko 0.062 Dissociation constant for DR, binding to control site for R
synthesis (number)
TAT subprogram
INIT TAT,, 1 Initial TAT mRNA concentration (number)
INIT TAT 1 Initial TAT concentration (number)
S 12.1 Proportionality constant for DR, stimulation of 747, (number)
g 1.804 “Amplification “exponent for 747, stimulation of 74T (number)
aTy =bT, rate constant for synthesis 7}, (hr™") -- from steady state
bT, 0.383 rate constant for degradation 7}, ( hr™)
aTAT =bTAT rate constant for synthesis TAT (hr" ) -- from steady state
bTAT 0.6904 rate constant for degradation 7AT ( hr')

Table 4. Steroid (Methylprednisolone) Model: Normalized Parameters for 380 g Rat.

Set Stoptime = 25 hours and run the model.

Double click in the middle of the plotting window to bring up the Choose Variables dialog. Remove
all variables and add those defined in Equation 25 through Equation 31. Keep all variables scaled on
the left except TAT,, and TAT; scale these two on the right.

1.

Plot the first two D, and DR. D rises instantaneously, reflecting the instantaneous injection.
Drug binding to receptor is nearly instantaneous, reaching its peak, where it binds 84% of the
receptor, at 0.2 hours. But, the DR curve decays much slower than the D curve because of the
difference in relaxation times The average lifetime (relaxation time) of a D molecule in the
body is given by (kc/Vd)” = 0.2 hours while that for DR is k' = 1.6 hr.

Now add DR, the drug receptor in the nucleus. Here we see the first significant delay in the
chain. It rises to a peak and then, as DR declines, DR, decays with a relaxation time of 1.75
hours. By the time the DR, peak occurs (about 1 3/4 hours after injection, D has disappeared.

Next add TAT,, and note that it is scaled on the right hand axis. It rises to approximately 4
times its resting concentration about 4 hours after injection.

Now add TAT; this final response peaks at 10 times its normal activity several hours after the
drug has disappeared. Moreover an enhanced enzyme activity persists for the better part of
the day.

The status of free cytosolic receptors can be seen by plotting R. (It’s a good idea to toggle
TAT and TAT,, off the graph to reduce clutter.) Almost immediately after injection, R drops
precipitously as it binds D to become DR. As D declines R builds back up slowly toward its
normal value. There are two sources of this build up 1. recycling from the nucleus, and 2.
synthesis of new R. You can evaluate both contributions by plotting SynR and Recycle. (You
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will have to select these in the Choose Variables dialog and then re-run the model). As you
might expect recycling is only important in the early phase, while synthesis maintains a fairly
steady supply and is responsible for the slow recovery in the later part of the run.

To examine the consequences of receptor down regulation, set Stoptime = 40 and Interval =
24, This will give an additional injection one day after the first. Run the model and toggle all
plotting variables off the graph except D (the stimulus) and 747 (the response). Although the
injections are identical, the second response is lower than the first. The system has been de-
sensitized by receptor down regulation. This is shown when you add R, to the plot. Soon
after the drug is applied there is a drop in the total amount of receptors to about 75% of
normal followed by a slow rise back towards normal as the DR, declines. R, has not fully
recovered by the time of the next injection; as a result, its responds to the new injection by
falling lower than it did to the first.

Down regulation caused by the negative feedback feed-back of DR, (Figure 24) is seen if the
mRNA coded for R, R, is added to the plot. It’s decline and rise correlates with R,,. To see
the effect of this feedback more clearly, toggle the O (overly) button and run the model with
the feedback removed by setting K5) equal to a number much greater than DR, say Ksp=
1E10. This essentially removes the feed back term , DR, /( K5y + DR,,), in Equation 44 by
making it close to zero. The results show that R,, no longer shows any dip; it remains in a
steady state. On the other hand both R,,, and TAT still show evidence of a substantial, down
regulation . Evidently there is a second cause. Since, under these conditions, the synthesis of
R remains constant this extra factor must involve the degradation terms, and indeed, when
their relaxation times are compared we find that the mean lifetime of a DR, molecule is kre”’
=1.75 hours, while that of an R molecule is ten times larger (bR =17.5 hours ). Thus, even
though half of DR, will recycle its R, the nuclear receptor drug complex is much more
susceptible to degradation than cytosolic free R. Exposure to the drug produces DR, which
has an enhanced rate of degradation so that R is reduced and the tissue becomes desensitized.

. A small bump on the R, curve occurs just after injection. It rises when substantial DR has
formed .but before much has been transported into the nucleus. In contrast to DR, cytosolic
DR is “protected”, it is transported, but not degraded. Movement from cytosol to nucleus
does not reduce R,,;, while the diminished degradation due to DR formation increases Ry,.
You can verify this by showing that the size of the bump varies inversely with k7.

46



